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Ordering, Purchasing, Receiving, and Transfers 
 
LightSpeed is designed to simplify the ordering process, whether it’s Product coming in 
for a stock order, a Customer backorder, or for an SRO.  Each sales document is able 
to request Product via an Order, and Purchase Orders can then be generated by 
Product, Supplier, or Order.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
Orders are structured like other sales documents, in terms of adding Products and 
Customers and configuring Options. They also have a unique set of features that allow 
the User to intuitively request Product for a Customer. Integrated with Quotes, Invoices, 
and SROs, the Order feature of LightSpeed allows you a quick transition from one stage 
of the sales process to another, giving you an immediate overview of the status of real-
time inventory levels.  

 
 

Ordering 
 
Orders may be thought of as requests for Product. They can begin life as a blank Order, 
to be populated from scratch, or they may originate as a backorder from an Invoice, 
Quote, or SRO.  They may reserve Product that is in inventory, or they may be 
converted to a Purchase Order that brings stock in from a Supplier.  Finally, they may 
be converted to an Invoice that sells the reserved Product to the Customer.  
   
Stock Order  
Choosing the New Stock Order option from the File menu allows you to request 
Product for your Inventory.  A new Order will appear with your company information 
populated as the Customer. Stock Orders cannot have inventory reserved for them, but 
their status in the Main Browser will change to reflect their progression.  
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Customer Order 
To create a blank Customer Order, click the Order button in the task bar.  A Customer 
Order looks identical to a Stock Order, except that you choose the Customer in the 
Customer section.   
 
Next, choose the Product you want, taking note of the quantities in the Inventory Status 
bar that appears on each line. You can cycle through these statuses by clicking the 
arrow icon.  The choices are: 
 
 Total – Total inventory of your entire stock 
 Available – Inventory available to reserve or sell 
 Reserved – Inventory reserved for a specific Order 
 In Warehouses – Total inventory in Warehouses 
 Coming For Customers – Backorder tagged to a specific Customer Order 
 Coming For Stock – Backorder tagged to a specific Stock Order 
 

 
 

If there is Product available to sell, the status bar will appear green.  If there is stock in 
inventory, but unavailable (reserved or in warehouses), the bar will appear orange. If 
there is no stock in inventory, but is ordered on a Purchase Order, it will appear gold. If 
there is no stock in inventory, and none ordered, the bar will appear grey. 
 
If the bar appears red, the inventory total is negative. This can happen if available 
inventory for a Product was zero but inventory was sold because Product was 
physically available, either due to a miscount or because it was reserved on an Order or 
stored in a Warehouse but was not released/transferred. This can be corrected with 
Adjust Inventory in the case of the miscount or by releasing/transferring inventory using 
the Order or Transfer Inventory respectively in the second case. 
 
Once a Product is assigned to an Order, a second status bar, the Product Reservation 
bar, will appear beside it.  If there is inventory available for the Order, you may reserve 
it.  To do this, save the Order, click the arrow icon in the Product Reservation bar, and 
choose the appropriate option.  You may reserve available inventory for the line item or 
the whole Order, release reserved inventory or cancel the request altogether.  You also 
have the option of marking the line or the entire order as Invoiced.  Normally, this 
happens automatically when a Related Document, such as a Quote, invoices the 
Product. However, in cases where a sales document refers to a particular Order but is 
not necessarily “related” to it, you can manually indicate that the Product or Order have 
been Invoiced.   
 
Note: When you save the Order, you will be asked if you want all available inventory 
reserved for the Order automatically. 
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Reserving inventory takes it out of the available pool until it is released, and changes 
the Inventory Status bar to a green color, with a Received status.  Releasing the 
Product will re-submit a Request for the stock.  Canceling the Request will change the 
status bar to red and cancel the request permanently.   
 
Once you have finished reserving available stock for your Order, click Save.  If you 
decide to create a Purchase Order solely from this Order, click the PO button and 
choose your Supplier from the Suppliers you have created.  In the case that you would 
like to sort and aggregate your Orders into PO’s according to default Supplier, Product, 
or date requested, see Purchasing (below). You can also use the Invoice button to 
invoice any reserved Product on an Order.  Once an Invoice created from an Order is 
saved, the Inventory Status bar changes to “Invoiced” status, becoming navy blue in 
color.  
 
Product can also be ordered directly from sales documents (ie. Quotes, SRO’s, and 
Invoices) using the Order button. On Quotes and SRO’s, the Order button will transfer 
all Products to an Unsaved Order. Once a sales document has been converted to an 
Order, the Product may then be reserved or requested as above.   
 
Statuses 
The status of an Order reflects its progress in the advancement of the process.  Once 
you have determined whether or not there is Product to be reserved, it will change to 
Processed.  When only some of the Product is reserved for an Order, the status will 
change to Partially Received. Once all Product on the Order has been reserved, the 
status changes to Received. Creating and saving an Invoice from the Order will result in 
the status showing as Invoiced. Cancelling an Order will show the status as Cancelled.   
 
Backorders 
On an Invoice, the Order button is used when there are Products being backordered, 
and only those Products with quantities in the Backorder column will be placed on an 
Unsaved Order when the Order button is used. The Tracker may be configured to track 
all open backorders, including those that are outstanding, received, and reserved. (see 
Tracking in Getting Started) 
 
Orders can be re-requested even when they have been Invoiced or Cancelled.    
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Purchasing  
 
To view your Purchasing documents – Orders, PO’s, and Supplier Invoices – click the 
Purchasing Browser icon located at the right side of the toolbar.   
 
In the Requests tab of the Purchasing browser, you are able to view Product requests 
from Orders on a line-item basis, sorted by date created.  Each line item will include an 
Inventory Status bar you can cycle through by clicking the arrow icon, as well as a 
pointer icon that links you to the original Order.  If Product is available, you can click 
this pointer icon to be taken to the Order to reserve it.  When the Requests tab screen 
is refreshed, you will notice that this Order has now dropped off the list of Requests for 
that Product.  Purchase Orders can be generated by selecting one or several line items 
and clicking the Generate PO button at the bottom of the browser.   
 
In the Actions tab, Product requests are sorted by default Supplier, Reorder POs, Drop 
Shipment POs, and GSX POs.  
 
 
Generate POs by Default Supplier 
Every Product requested that has in its profile a default Supplier indicated will be found 
under this heading, sorted by Supplier.  By clicking Generate PO beside a Supplier, an 
unsaved Purchase Order will be created comprised of all the Products requested with 
that Supplier listed as the default. An arrow icon will appear beside each line item; 
clicking it will drop down a list of the Orders that had requested this Product, as well as 
any Quotes associated with that Order, along with the Customer information.  Clicking 
the pointer icon on any Order listed will take you to that Order.  
 

 
 
You may remove requests from your unsaved PO by selecting the line and clicking 
Delete.  You will then be asked if you want to cancel the Order request completely, or 
re-request it for later approval.   
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Click Save on the PO to assign it an ID number.  This is the number you will give your 
Supplier as your PO number.  
 
Reordering PO by Default Supplier 
In the Inventory tab of each Product profile, you are able to set reorder quantities when 
your stock reduces to a certain point.  When this point is reached, this Product will 
appear as a request for a Reordering PO.  As with regular POs by default Supplier, 
generating a PO will aggregate reorder requests, but it will place them directly into an 
unsaved Purchase Order, bypassing Orders.   
 
Drop Shipment POs 
Clicking Generate PO for a Drop Shipment PO request will create an unsaved Purchase 
Order that includes both the Supplier information and the Customer information in the 
Drop Shipment tab. When you place this PO with your Supplier, the document will 
indicate to them that it’s a drop shipment.   
 
GSX POs 
GSX POs are for Orders originating on SROs. The Customer information will appear in 
the GSX tab of the Purchase Order. Individual GSX POs are created for every SRO 
Order submitted, and are processed like other Orders, with Apple as the Supplier.  
 
 
Receiving  
 
Once the PO is processed, it is ready to have the Product marked as Received when it 
arrives from the Supplier.  To receive Product, go to the original PO’s Receiving tab and 
enter what you have received of the total order.  If a Product is serialized, it is necessary 
to click the Product line to scan or enter the serial number of the Product.  If you do not 
receive the total quantity of a Product that was initially ordered, just enter the amount 
you did receive.  Click Save.   
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If only some of the Product is received for a Purchase Order, its status will be set to 
Partially Received.  If you receive more Product from the Supplier on a particular 
Purchase Order, go to the original Purchase Order and click the Receiving tab.  In the 
Qty Rcvd column, ADD the quantity you received that day to the quantity that had 
previously been received.  For example, if you had ordered 10 iPod Nano 2gb Black, 
and 2 had been received on Monday according to the procedure outlined above, there 
should be a quantity of 2 in the Qty Rcvd column.  Then, when 4 more arrive on 
Wednesday, the number you will enter in the Qty Rcvd column will be 6.  If the Product 
is serialized, you will have to enter the 4 serial numbers. Click Save to enter any 
modifications. 
 
Note: If the Product you’re receiving does not have a UPC code in its profile, a grey U 
will appear.  Clicking it will prompt a request for you to enter it, which saves it to the 
Product profile.  If a red U appears, the UPC code is already in the profile, and can be 
modified by clicking the icon, if required.  
 
Supplier Invoices 
Once you receive an invoice from your Supplier for a shipment on a PO, you can create 
a Supplier Invoice reflecting this billing by using the Invoice button on your LightSpeed 
Purchase Order.  This generates an invoice which will eventually be exported to your 
accounting software as a payable.  The Supplier Invoice should be created each time 
you receive product from your Supplier, and will include only the product you received.  
That is, if 5 Nanos were ordered on a PO, and on Monday 2 were received, and a 
Supplier Invoice is created, a quantity of 2 will appear on the Supplier Invoice.  Then, if 
another 3 were received on Thursday, a quantity of 3 will appear on the next Supplier 
Invoice you create from this PO.  Click Save.   
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Note: You can create a Supplier Invoice each time you receive Product, or you may 
choose to wait until you receive an actual invoice from your Supplier before creating it 
so that your Supplier Invoice exactly reflects the billing of your Supplier.  When your 
Supplier Invoice is Posted, a green “P” will appear at the bottom left of the window.  
When it is exported, that will change to a blue “E”. Posted Supplier Invoices cannot be 
changed.  (see chapter on Accounting Exports) 
 
Statuses 
As your Purchase Order advances through its various stages, its status is reflected at 
the bottom of the window.  Once saved, the PO is “Processed”.  “Partially Received” 
indicates that some, but not all, of the Products on the PO have been received.  Once 
they are all received, the status changes to “Received”.  The last 2 statuses are set 
manually – “Cancelled”, in the event that the PO has been cancelled with the Supplier, 
and “Invoiced”, which indicates that all Product has been received and all Supplier 
Invoices have been created for this PO.   
 
Once a Supplier Invoice is saved, the status will change from None to Invoiced. When 
you pay your Supplier for a particular Invoice, you must change the status to Paid 
manually.  
 
To use the Tracker to track your outstanding POs and Supplier Invoices, choose the All 
POs (various statuses) and the All Supplier Invoices (various statuses) and install them 
on your Tracker.  
 
Drop Shipments 
If the Product on an Order or a PO is being sent or delivered directly to the customer, 
and involves movement outside the regular channels of inventory, you are able to flag 
the Order or PO in the Options tab using the Drop Shipment checkbox, and by 
indicating the Shipping Method using the pull-down menu just below.  Drop Shipment 
Customer information is then attached to your sales document.  Note: Inventory 
shipped via a drop shipment must still be received into inventory and invoiced on an 
Invoice.   
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Transfers and Warehouses 
 
LightSpeed is able to accommodate up to ten virtual warehouses, allowing you to be 
able to track stock that exists in your store but that you do not want to appear as part 
of your available inventory.  To set up your warehouses, choose the Warehouses option 
of the Tools menu and select the Warehouse to rename it.  You may wish to set up 
Warehouses for your RMA inventory, store demos, damaged product, or simply your 
stockroom.   
 
Transfers 
Once a Warehouse has been set up, you are able to transfer stock from your inventory 
to any of these virtual warehouses.  In the profile of a Product, go to the Inventory tab 
and click the Transfer button.  The Transfer Inventory window will appear, listing the 
current status of all existing inventory and Orders for that Product.  Below the status 
section, there will be 2 pull-down menus indicating the origin and destination of the 
Product in question.  Your available stock is known as “Inventory”, and any 
Warehouses you’ve set up will appear here also.  Choose the origin of the stock with 
the pull-down menu marked “From”, and the destination of the stock with the pull-
down menu marked “To”.  If the Product is non-serialized, simply enter the quantity of 
stock you want to transfer in the Qty field, and click Transfer. You will be notified that 
the transfer was successful.  The available inventory will decrease, and the quantity will 
now appear in the Warehouses status (this status will total the stock in all Warehouses).   
 

 
 
If the Product is serialized, all available serial numbers in the Product origin you’ve 
chosen will appear below. Choose the serial number(s) you wish to transfer, and click 
Transfer.  You will be notified the Transfer was successful.   
 
To view the Transfer History of any given Product, go to the History (With Transfers) tab 
in the Product profile.  To have an overview of the stock in any Warehouse, go to the 
Inventory Valuation section of Reporting, and choose the Warehouse you want to 
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check. Click Preview or Print.   
 

 
 
 

 
Adjusting Inventory 
 
If you need to add inventory outside the normal channels of Invoicing and Purchasing, 
you are able to make manual adjustments to your inventory levels. Stock that must be 
written in because it has been found or balanced against another Product may be 
addressed using the Adjust button in the Inventory tab of the Product profile.   
 
 

 
 
Non-serialized Products 
Adjustment of non-serialized Products allows you the choice to set the total quantity 
you wish to adjust the inventory to, or to add a certain quantity to your existing 
inventory.  There is also a field which allows you to set the cost of the quantity you’re 
adjusting in, which will be calculated into the cost average total for that Product. There 
is also a Note field which allows you to enter information regarding the adjustment, 
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useful for later reference. Click Save to save your changes; you’ll notice the Total and 
Available quantities change in the statuses listed above.  
 

 
 
Once the adjustment is saved, you can go back to your Product History and see the 
change.  If you saved a note with the adjustment, an indicator icon will appear which 
will display the note when clicked. 
 

 
 
Serialized Products 
Adjustments made to serialized Products are done by clicking the New button in the 
Adjust Inventory window, and entering the serial numbers you are adding in the New 
Serial Numbers field.  As with non-serialized Product, you may then edit the system 
cost for the additions as well as a Note. Click Save and the totals will be adjusted. You 
will see the adjustments made to the Product’s History are logged separately for each 
serial number, and a Note icon will appear beside each. Clicking on the Serial Numbers 
tab will display the new serial numbers you have added to inventory.  


